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Enhance Your Productivity
Your Kensington input device is comfortable and easy to use, and its MouseWorks® software helps you work more
quickly and efficiently. MouseWorks gives you instant access to timesaving features. Double-click, cut, paste, save,
and much more—with the click of a single button. Create customized menus of your favorite commands, too.

And it’s all easy to do. Follow the simple instructions in this QuickStart to get started right now.

Contents
• Installing the MouseWorks Software

• Connecting Your Kensington Input Device

• Cool Things You Can Do with Your Kensington Input Device

• Getting Started with MouseWorks Software

• A Word About Comfort and Safety

• Cleaning Your Input Device

• Warranty, License and FCC information

• Contacting Kensington

Contacting Kensington

Technical Support
In North America/Europe, technical support is available to all registered owners of Kensington products. There is
no charge for technical support, except long distance charges where applicable.

Technical Support Tips
• You may find the answer to your problem in the Frequently Asked Questions (FAQs) in the Support area of the

Kensington Web site (http://www.kensington.com/support)
• Call from a phone where you have access to your computer.
• Please be prepared to provide the following information:

- Name, address and telephone number
- The name of the Kensington product
- Make and model of your computer
- Your system software and version
- Symptoms of the problem and what led to them

Support by Electronic Mail
Troubleshooting information and answers to frequently asked questions are available 24 hours a day on the
Kensington Web site at: www.kensington.com.

Contact Kensington at the following addresses:
Internet E-mail: tech@kensington.com
Internet File Server: ftp.kensington.com

Support by telephone
NORTH AMERICA: Technical support is available by telephone Monday through Friday 9 a.m. to 7 p.m., E.S.T. Call
toll-free (US and Canada only) 800-535-4242.

EUROPE:  In Europe technical support is available by telephone Monday through Friday 09:00 to 21:00, Saturday
and Sunday 12:00 to 18:00 (Central European time). Please call one of these numbers:
Austria 0800-295791 Germany 0800-1810654 Spain 900-993129
Belgium 0800-16778 Ireland 1-800-552180 Sweden 020-795845
Canada 610-266-9505 Mexico 001-880-535-4242 Switzerland 0800-558605
Denmark 800-17838 Netherlands 0800-0222-694 United Kingdom 0800-894383
Finland 9800-13228 Norway 800-11335 United States 610-266-0560
France 0800-906053

If your country is not listed, please call 610-266-0560 (USA), or +31 30 634 4280 (Europe).
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Warranty, License and FCC Information

MODIFICATIONS: Modifications not expressly approved by Kensington may void the user’s authority to operate the device under FCC
regulations and must not be made.
SHIELDED CABLES: In order to meet FCC requirements, all connections to equipment using a Kensington input device should be made using
only the shielded cables provided.
Kensington Technology Group

Declaration of Conformity Compliance Statement for Kensington [Product]
This Kensington Input Device complies with Part 15 of the FCC Rules. Operation is subject to two conditions: (1) This device may not 
cause harmful interference, and, (2) this device must accept any interference received, including interference that may cause undesired
operation. As defined in Section 2.909 of the FCC Rules, the responsibility party for this device is: Kensington Technology Group, 
2000 Alameda de las Pulgas, Second Floor, San Mateo, CA 94403, 610-266-0560.

Canadian Department of Communications Compliance
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatuses set out in the Radio
Interference regulations of the Canadian Department of Communications.
Cet appareil numèrique respecte les limites de bruit radioèlectrique aux appareils numèriques de Classe B prescrites dans le Règlement
sur le brouillage radioèlectrique du Ministère des Communications.

5-Year Warranty Information
KENSINGTON TECHNOLOGY GROUP, a division of ACCO Brands, Inc. [“KENSINGTON”] warrants this PRODUCT against defects in material
and workmanship under normal use and service for five years from the original date of purchase. KENSINGTON, at its option, shall repair or
replace the defective unit covered by this warranty. Please retain the dated sales receipt as evidence of the date of purchase. You will
need it for any warranty service.
In order to keep this warranty in effect, the product must have been handled and used as prescribed in the instructions accompanying 
this warranty. This warranty does not cover any damage due to accident, misuse, abuse, or negligence. This warranty is valid only if the
product is used on the computer or system specified on the product box. Please check product box for details, or call technical support at
800-535-4242 (USA and Canada only) or a number from the Support by Telephone section of this manual.
Repair or replacement, as provided under this warranty, is your exclusive remedy. KENSINGTON shall not be liable for any incidental or
consequential damages. Implied warranties of merchantability and fitness for a particular purpose on this product are limited in duration to
the duration of this warranty.
Some states/countries do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation or 
exclusion may not apply to you. Some states/countries do not allow limitations on how long an implied warranty lasts, so the above
limitation may not apply to you. This warranty gives you specific legal rights, and you may also have other rights that vary from state 
to state and country to country.
This QuickStart and the software it describes are copyright © 2001 Kensington Technology Group, a division of ACCO Brands, Inc. The
software described in this document is furnished under a license agreement, and may be used only per the terms of the agreement. Any
unauthorized copying, duplicating, or other reproduction of the contents hereof is prohibited without written consent from Kensington
Technology Group. All Rights Reserved. Patents Pending.
Kensington, MouseWorks, Expert Mouse and Turbo Mouse are registered trademarks, and Scroll Ring is a trademark of ACCO World
Corporation. Microsoft Office and Windows are registered trademarks of Microsoft Corporation. Apple, Macintosh and Mac are registered
trademarks of Apple Corporation. All other registered and unregistered trademarks are the sole property of their respective owners.
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Installing the MouseWorks Software

Installing the MouseWorks Software
Remember to save your MouseWorks CD in case you ever need to reinstall the software.  If you are running
Windows NT,® please remember to make a recovery disk.

IMPORTANT: Until you install the MouseWorks software, your new input device may not
work as expected (for example, if your input device has extra buttons or a scroll wheel,
they will not work without the software).  Your input device will work as a basic mouse as
soon as you plug it in, but to make full use of the device, you must install the software.
For best results, install MouseWorks software from the included CD and restart your
computer before connecting your Kensington input device.

See Getting Started with MouseWorks Software to find out how the MouseWorks software can help you
work more efficiently and comfortably.

Installing for Windows®
98 or later

1. Turn on your computer (if it’s not already running) and insert the MouseWorks CD into your CD-ROM drive.

2. MouseWorks Setup should start automatically. If it doesn’t, you can run it from the Start menu:

a) Click the Start button and choose Run.
b) Click Browse and choose the CD-ROM drive.
c) Select Mworks/setup.exe and click OK.

3. Read the license agreement in the installer and click Yes to accept the agreement.

4. When the MouseWorks installation is complete, MouseWorks Setup restarts your computer.

NOTE: Once the software is installed, always use MouseWorks to control the input device.
(See “Getting Started with MouseWorks.”) Do not use the Mouse control panel supplied
with Windows.

Installing for Macintosh® computers
1. Turn on your computer (if it’s not already running) and insert the MouseWorks CD into your CD-ROM drive.

A window showing the MouseWorks files should appear on your desktop.

2. Double-click the MouseWorks Installer.

3. Read the license agreement in the installer and click Accept to accept the agreement.

4. When the MouseWorks installation is complete, restart your computer.

2 • MouseWorks
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Connecting Your Kensington Input Device

Registering Online
Take a minute to register your Kensington input device and MouseWorks software. Registered customers are eligible to
receive free technical support, notification of new products, and software updates. To register, start MouseWorks and choose
Online Registration from the Help menu, or start your Web browser and go to: http://www.kensington.com/register

Connecting Your Kensington Input Device
Look closely at the connector. Your Kensington input device may include one or more connectors: USB, serial, or
PS/2 for PC computers; USB or Apple Desktop Bus (ADB) for Macintosh.

Which connector do you choose?
• If your input device comes with a USB connector and your computer has a USB port—choose USB. It will

provide the best and simplest connection.

• If USB is not an option, use the connector that works with your computer.

CAUTION: Always turn off your computer before connecting or disconnecting 
any non-USB hardware.

Connecting to a PC:

To connect to a Do this:

USB port Plug the cable into your computer’s USB port (or a USB port on a hub connected to your computer).
You do not need to turn off your computer before connecting or disconnecting a USB device.

NOTE: To use MouseWorks with a USB connected device on a PC, you must be
running Windows 98 or higher.

PS/2 mouse port 1. Turn off your computer.

2. Plug the cable into the computer’s round, 6-pin mouse port. If the PS/2 connector is
on an adapter, first plug the cable into the adapter, then plug the adapter into the
computer’s PS/2 port.

9-pin serial port 1. Turn off your computer.

2. Plug the cable into your computer’s 9-pin serial port. If the serial connector is on an
adapter, first plug the main cable into the adapter, then plug the adapter into your
computer’s serial port.

MouseWorks • 3

Warranty, License and FCC Information

Software License
This is a license agreement and not an agreement for sale. This is a legal agreement between you and Kensington Technology Group, 
a division of ACCO Brands, Inc. Please read this Agreement carefully before installing or running the software.
This software program(s) is protected by United States copyright and/or patent law and international treaty provisions. You may:
a) use the program(s) on any computer you wish, including business, home, and/or portable computers as long as there is no possibility 

the program(s) is in use simultaneously on two or more machines;
b) make backup copies as necessary for personal use;
c) transfer the program(s) and license to another party if the party agrees to accept the terms and conditions of this Statement. You may

transfer the program(s) including the original program(s), backup copies, manuals, documentation and any other related materials or
destroy any copies not transferred; this includes all portions of the program contained or merged into other programs.  Any transfer other
than as expressly permitted shall be void and shall result in termination of this license.

United States Government Restricted Rights
The program(s) and documentation are provided with Restricted Rights. Use, duplication, or disclosure by the Government is subject to
restrictions as set forth in subparagraph (c) (1) (ii) of The Rights in Technical Data and Computer Software, clause DFARS 52.227-7013.
Contractor/manufacturer is Kensington Technology Group, 2000 Alameda de las Pulgas, Second Floor, San Mateo, CA 94403.

LIMITED WARRANTY: Software
Kensington warrants the CD-ROM or Diskette on which the program(s) is furnished to be free from defects in materials and workmanship
under normal use. Kensington’s entire liability and your exclusive remedy shall be the replacement by Kensington of any CD-ROM or
Diskette. For CD-ROM or Diskette replacement, call Kensington at 800-535-4242 (USA and Canada only) or a number from the Support by
Telephone section of this manual.
THE PROGRAM(S) IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
Kensington does not warrant that the functions contained in the program will meet your requirements or that the operation of the program
will be uninterrupted or error-free.
IN NO EVENT WILL KENSINGTON BE LIABLE TO YOU FOR ANY DAMAGES INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH PROGRAM(S) EVEN IF KENSINGTON
OR AN AUTHORIZED DEALER OR EITHER OF THEM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY
ANY OTHER PARTY.
Some states/countries do not allow the exclusion or limitation of consequential damages, so the above limitation and exclusion may not
apply to you. This warranty gives you specific legal rights and you may also have other rights that vary from state to state and country to
country. Some states/countries do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you.

Federal Communications Commission Radio Frequency Interference Statement
Note: This device has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
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Cleaning Your Input Device

Cleaning Your Input Device
Input devices using mouse or track ball technology need to be cleaned periodically, but newer input devices
using optical technology do not. Optical products are self-contained and should not be opened. Cleaning
frequency for traditional mice and trackballs depends on how you work with your device and the work surface
you use. When moving the mouse or ball of the trackball feels slow or rough, it's time for a cleaning.

To clean your input device
1. Turn off your computer.
2. Unplug the input device from the computer.
3. Remove the ball.

a. To access the ball inside a mouse, you will have to remove the ballhousing cover by turning it counterclockwise.
b. To remove the ball from a trackball, invert the trackball. Then while holding the ball in your free hand,

press the spoon-shaped lever on the bottom of the trackball. The ball will pop free from the trackball, 
or you may simply grab the ball with your finger tips and pull it out of the base.

4. Clean the ball using a Kensington premoistened Cleaning Wipe or tap water and, if needed, a mild detergent.
Dry it with a lint-free cloth. We recommend a Kensington Lint-Free Wipe.

5. Clean the ball cage. Use a Kensington premoistened Cleaning Swab or a cotton swab with rubbing alcohol. 
If lint is trapped inside the ball cage or on the rollers, use a cotton swab with rubbing alcohol to loosen it.
Allow surfaces to dry completely before you reassemble.

6. Reassemble. Put the ball back into the ball cage. On a mouse, replace the ballhousing cover, and turn the
cover clockwise until it locks.  For a trackball, press the ball gently but firmly back into its socket.

7. Reconnect the input device.
8. Turn on your computer.
Your Kensington input device requires no other maintenance.

MOUSE TRACKBALLS

MouseWorks • 174 • MouseWorks

Connecting Your Kensington Input Device

NOTE: Some models of Expert Mouse may require you to connect the cable to the trackball base. On
these models plug the round, 8-pin end of the cable into the port on the back of the Expert Mouse.

Connecting to a Macintosh computer:

To connect to a Do this:

USB port Plug the cable into your computer’s USB port. You may also use the spare 
USB port on your keyboard or a USB port on a hub connected to your computer. 
You do not need to turn off your computer before connecting or disconnecting a 
USB device.

Apple Desktop Bus 1. Turn off your computer.

(ADB) port 2. Plug the cable into an ADB port either at the back of the computer or on the
keyboard. If you do not have a free ADB port, you may need to unplug the mouse
you are currently using.

CAUTION: Always turn off your computer before connecting or disconnecting 
any non-USB hardware.
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Cool Things You Can Do with Your Kensington 
Input Device!

Your Kensington input device excels at basic mouse and trackball tasks. But it does more than that. Take a 
few minutes to experiment with the great features MouseWorks offers. Here are just a few of the ways that
MouseWorks can save you time and energy.

Customize the buttons to perform a wide variety of tasks
MouseWorks lets you do other things with the buttons on your input device in addition to basic mouse clicks.
When you start MouseWorks, you will see a picture of your input device. Next to each button on the picture is a
response menu that lets you choose a function for the button:

Here are a few examples of things you can do with the press of a button:
• Set a button to double-click. Never worry again about clicking too slowly or moving the

cursor between clicks.

• Launch any application or jump to your favorite Web sites with just one click.

• To fill out forms easily, set a button to type a block of text, such as your name, address, and
phone/fax numbers.

• Set another button as your application menu, and move effortlessly between applications.

These and many other options are available in the MouseWorks software. For instructions on
how to use these options, see the next section, Getting Started with MouseWorks Software, or
refer to the MouseWorks Help.

MouseWorks • 5

Cool Things You Can Do with Your Kensington Input Device
A Word About Comfort and Safety

Computer User Health Information
In recent years, medical attention on occupational injuries has identified normal, seemingly harmless activities as
a potential cause of a wide range of problems collectively known as Repetitive Stress Injuries (RSI) or Cumulative
Trauma Disorders (CTD).

It is now recognized that any repetitive motion may contribute to these health problems. As a computer user, you
might also be at risk.

The most commonly accepted causes of this type of disorder are repeated, forceful actions, usually in an
awkward position or posture, without sufficient rest to allow the body to recover, especially in the presence of
cold or vibration. These repetitive actions may cause tendons, ligaments, and other soft body parts to become
irritated and inflamed. In addition, experts have noted that stress, both on the job and at home, can be an
important contributing factor in the onset of symptoms.

By paying attention to the way you perform your work, use your computer and phone, play sports, and work
around the house, you can identify the behaviors that may be putting you at risk.

A thorough work site analysis by a qualified expert is important in order to reduce the risk of repetitive motion
injuries. If you experience pain, swelling, numbness, or weakness in your wrists or hands (especially during
sleep), see your physician immediately.  These symptoms could mean that you are developing a repetitive 
stress injury that requires prompt medical attention. For more detailed information, consult your doctor or a
reputable book.

16 • MouseWorks
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A Word About Comfort and Safety

• Place the items that you use regularly within reach.  Avoid reaching and stretching.

• If you use a keyboard drawer, try to place the input device in the same tray as the keyboard. If you 
can’t arrange this, try to place the input device nearby.  Try to avoid reaching up, away, or to the side 
for the input device.

• Don’t sit in one position for too long.

• Take breaks.  This doesn’t mean that you have to stop working. If you have been typing, take a filing break 
or make some phone calls. Frequent short breaks are probably better than a few long ones.

• Stand up and stretch during your workday. Try to do this frequently.

• Keep a light touch on your input device and keyboard.

• Look into stress-reducing techniques that might work for you.

Kensington MouseWorks software helps you work comfortably
Kensington MouseWorks software is designed to make your Kensington input device a powerful, more efficient
tool that streamlines your work. With MouseWorks software, you will be able to take advantage of the following
features to help you work more comfortably.

• Use MouseWorks’ advanced Acceleration control to minimize mouse movement, especially on big screens.

• Use the Drag feature to make dragging easier.

• Use Snap to Default to reduce hand movement, including the number of times you need to move between
the input device and the keyboard.

• Use the Double-Click feature to avoid repetitive clicking.

• Use the Slow Cursor feature to help you avoid small, tense motions during high-precision work. 

• Use Pop-Up Menus to keep frequently used commands at your fingertips. This also reduces switching back
and forth between the input device and the keyboard.

• Use the Rest Reminder to help pace yourself. If you become so absorbed in your work that you lose track 
of the passing minutes, the Rest Reminder can remind you that it’s time to change what you are working on,
stretch, move around a little bit, or take a break.

Getting Started with MouseWorks Software

Be kind to yourself. MouseWorks software settings help eliminate repetitive
movements that put strain on your hands and wrists.
• Pace yourself by setting a Rest Reminder. If you lose track of time, the Rest Reminder lets you know when it’s

time to work on something different, stretch, move around a little, or take a break.

• Use the Drag feature to drag without having to hold down a button.

• Reduce repetitive clicking by assigning Double-Click to a button.

• Try Snap to Default to reduce hand movement, including the number of times you need to move between your
Kensington device and the keyboard.

Streamline your work with powerful MouseWorks software features.
• Create Pop-Up Menus to streamline everyday tasks and to keep frequently used commands at your fingertips.

• Tailor your input device to your favorite applications with Application Sets.

• Use MouseWorks’ advanced Acceleration controls to adjust the cursor’s movement speed. Zip your cursor
across a big screen or slow it down for small and detailed movements, all within one convenient setting.

Getting Started with MouseWorks Software
MouseWorks software is easy to use.  Start by trying a few simple features.  Then experiment with custom button
options for the application you use most.

Starting MouseWorks 
On a Windows 98 or later computer: Click on the Start menu, then choose Programs > Kensington
MouseWorks > Kensington MouseWorks.
On a Macintosh computer: Choose Kensington MouseWorks from the Control Panels sub-menu of the Apple®

menu.  You can also double-click the Kensington MouseWorks icon in the Kensington folder where you installed
the software.

NOTE: This QuickStart is illustrated with the Expert Mouse, but every Kensington input
device supports these same features. 

6 • MouseWorks
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Getting Started with MouseWorks Software

Getting Around MouseWorks
Most MouseWorks features are arranged in a series of tabs. The two outer tabs separate the two main categories
of MouseWorks features:

• The Settings for tab includes those features that can change from application to application. These features
appear in a set of three inner tabs.

– The Buttons tab allows you to choose functions for each button on the input device.

– The Scrolling tab lets you adjust the scrolling speed, scrolling style, and Scroll Ring™ direction.

– The Movement tab allows you to turn on special options that change the way the cursor moves on screen.

MouseWorks • 714 • MouseWorks

A Word About Comfort and Safety

• You should not have to reach or stretch to use either the keyboard or the input device.

DO DON’T

Correct and Incorrect Ways to Arrange Input Device, Keyboard, and Display

• When you return from a break, slightly reposition the keyboard and input device to readjust them to
comfortable positions. 

Furniture and posture
Arranging your office furniture is one of the most important things you can do to make your work space
comfortable. Adjust the height of your chair and desk so that your body is comfortably aligned.

• Stay relaxed and sit relatively upright, but don’t force yourself into an unnatural position. Let your chair support
you. Have your knees slightly lower than your hips, so that the angle of your torso and thighs is more than 90°.

• Support your lower back with your chair’s backrest.

One Way to Arrange Your Work Space
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A Word About Comfort and Safety

Creating a comfortable work space
Many factors go into creating a comfortable work space, including proper placement and adjustment of furniture
and equipment, good lighting, and other environmental considerations.

In this section, we make some suggestions about how you can work more comfortably.  Keep in mind, however,
that these are only suggestions.  Comfort is very personal, and only you can judge what works best for you.

Position of keyboard and input device
Try to place the keyboard and input device so that your arms and hands are in a relaxed, comfortable, and
natural position.  When the input device and keyboard are correctly positioned:

• Your forearms should be parallel or almost parallel to the floor and your wrists and hands should be in line
with your forearms.  Your wrist should not be extremely flexed or extended.

DON’T DO DON’T

Keep Wrist and Hand in Line with Forearm

• Your hands and wrists should be in roughly the same neutral position as when your arms are loosely hanging
by your sides.  Your wrist should not be bent too much to one side or the other. 

DON’T DO DON’T

Keep Wrist and Hand in Line with Forearm

MouseWorks • 13

Getting Started with MouseWorks Software

The System-Wide Settings tab includes features that apply globally, regardless of which application you are
currently running. Within this main tab, three inner tabs give you access to these features.

The Acceleration tab lets you adjust the speed of cursor movement.

The Click Speed tab allows you to adjust two things:

• the speed of the double-click, and

• how precise you must be when pressing left and right buttons simultaneously in order for the button presses
to be interpreted as a chord.

NOTE: To perform a chord, press two mouse buttons (left and right) at the same time.  You
can assign functions to a chord in the same way that you assign button functions in the
Buttons tab.
The Rest Reminder tab lets you set a reminder—a beep and/or an on-screen message—to prompt you when
you have been working for too long without a break.

Click on a tab to view or change its settings.

Standard Settings
• When you first install MouseWorks, all of the buttons on your Kensington input device are set to perform

common mouse functions such as click, right-click, etc.

• If your device has more than two buttons, at least one chord is available for your use, and a default chord
response is assigned. To determine which combination(s) of buttons on your device will function as a chord,
refer to the illustration of your device in the MouseWorks software. You may choose which function you want
for the available chords, or leave the default settings in place.

You can use MouseWorks to change the settings for the other buttons, setting them up to perform any function
you wish. Any function that you can assign to a button, you can also assign to a chord.

8 • MouseWorks
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Getting Started with MouseWorks Software

Adjust the cursor and click speeds, and choose scrolling options.
• Click the System-Wide Settings tab, then click the Acceleration tab. Drag the slider left or right to adjust

the cursor movement speed. For more control, click the Fine Adjustment check box and adjust the sliders.

• If you have a mouse or trackball with a scroll wheel, you can roll the wheel forward to scroll up and back to
scroll down in applications that support it. If your input device does not have a scroll wheel, you can use a
button for scrolling—use the Buttons tab to assign one of the scrolling features (Scroll Up, Scroll Down,
AutoScroll, or Scroll When You Move the Mouse) to a button.

• If you have a trackball with a Scroll Ring device, you can use any finger to turn the ring. A clockwise turn
scrolls down and a counterclockwise turn scrolls up in applications that support scrolling. Although the Scroll
Ring device is preset to scroll down with a clockwise turn, it easily can be reversed through MouseWorks—
try both directions to see which is most comfortable and intuitive for you.

• The Scrolling tab lets you adjust the scrolling speed, change direction on the Scroll Ring device, and switch
between the Kensington and Microsoft Office® scrolling styles.  For best results, always use the Office 97
scrolling style with applications that are Office 97-compatible. For any other application, deselect the Office 97
scrolling style option.

Button Press and Response
MouseWorks makes a distinction between a Button Press and the Response.

• A Button Press is the action you take; it is what you press. 

• A Response is the signal that MouseWorks sends to the computer; it is what you get.  MouseWorks responses
are available from the Response Menu associated with each mouse button.

Set up the mouse buttons to do what you want them to do.
The three steps below outline how to assign a response from the response menu to a mouse
button press.

1. Click the Settings for tab, then click the Buttons tab.

2. Click the Response Menu for a button.

3. Choose the response you want from the list. If the response requires more information, a
pop-up window will prompt you. The Response Menu will now show the response you have
assigned to the button press.

Your changes take effect immediately. To try the new response, just press the mouse button it is
assigned to.

MouseWorks • 9

Getting Started with MouseWorks Software

MouseWorks offers on-screen help.
• The MouseWorks Guide is a complete on-screen reference manual for MouseWorks. To open it choose

MouseWorks Help from the Help menu. Help will be displayed in your default browser (PC users) or the
Apple Help Viewer (Mac users).

• For help on working with the currently visible MouseWorks window:

Mac users: To display the Help Window, choose Help Window from the Apple menu, or choose MouseWorks
Help... from the Help menu, or simply press command-H.  A floating window will dynamically display
information about whatever control the mouse points at.

To activate Balloon Help, choose Show Balloons from the Help menu. A small help balloon will pop up 
next to whatever control you point at with the mouse. To turn off the balloons, choose Hide Balloons from 
the Help menu.

A Word About Comfort and Safety
Here are some suggestions about how you can work more comfortably with your Kensington input device. 
Keep in mind, however, that these are only suggestions.  Comfort is very personal, and only you can judge what
works best for you.

Using a Mouse Grasp the mouse lightly between your fingers and thumb; do not apply too much
pressure when lifting and moving the mouse. Allow your fingers to rest lightly on 
the buttons. This will not cause accidental clicks. Experiment with different button
options to determine the best primary and secondary buttons for your hand size.
With the MouseWorks mouse, it will be easier to click some buttons with the thumb.

Using a Trackball Most users find the best way to handle a trackball is by using the fingertips to 
control the ball while using the thumb and pinky, or ring finger, to click the buttons.
There are two basic ways to use a trackball, depending on its shape. With Expert
Mouse and Turbo Mouse it is best to hover slightly above the unit to keep your wrist
straight. The other devices work best when you place the blade of your hand (along
the edge of your pinky finger) on the desktop next to the unit. Allow your hand to
drape over the unit. This should keep your wrist in a comfortably neutral position.
The thumb will be on one side of the ball and the other fingers on either the ball or
the other buttons.
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of the words “Settings for:” is a pop-up menu. When MouseWorks is first installed, the phrase “All Other
Programs” appears in the menu window.  As you create Application Sets, you can view them by pulling 
down this menu and choosing an application name.

MouseWorks already has a number of Application Sets that have been customized for common applications. If you
choose one of the predefined Application Sets, the buttons will already be programmed to automate many tasks.

To use a Kensington Application Set:

1. Open MouseWorks and bring it to the front.

2. Click on the pop-up menu next to Settings for: (It will say “All Other Programs” the first time you add 
an application set).

3. Choose Add/Change Sets. This opens the Add/Change Application Sets window shown.

4. Highlight the Application Set you wish to use from the Inactive Sets list on the right side of the window.

5. Click copy.  You will see the application name appear in the In Use Sets on the left side of the window.

If you wish, while the application name is still selected in the In Use Sets window, you can click Properties
to change the label for the program and add comments.

You may also add Application Sets that are not already included. To do this, click the New button in the
Add/Change Application Sets window and follow the on-screen instructions. This process is simpler if the
application is running when you want to add it.

Try these easy button responses.
Double-Click Use just one click to open documents, applications, and folders.

Drag Select text or move objects without holding down a mouse button.

EasyLaunch Open a document, application, or Web page with one click.

Shortcuts Save time. With Shortcuts, cut, paste, edit, open files and more at the touch 
of a button.

Paste Text Insert your name, address or any other text into any document.

Scrolling Scroll up, down, AutoScroll, and more with a click.

Application Menu Pop up a menu of the applications you have running.  Switch applications easily.

Instant Menu Instantly pop up the main menu of the current application.

Snap to Default
Snap to Default makes your cursor jump automatically to the default button every time a dialog window opens, 
so you don’t have to move the cursor there manually.  Choose Snap to Default from the Options menu. 
A checkmark next to the Snap to Default item in the menu shows that the option is turned on. To disable it,
simply select it again.

Made a mistake?
You can always use the Restore options on the File menu to revert to the default standard settings.

Choose custom settings for your favorite applications
Application Sets change the way your input device works with each of your favorite applications. MouseWorks
automatically switches your settings whenever you start a program that has a set defined for it.  For instance:

• You can create a set for your Web browser that lets you click to AutoScroll and to open a pop-up menu 
with browser options.

• You can create another set for your word processing application that lets you paste text and open files at 
the click of a mouse button.

Using Application Sets
The two main MouseWorks tabs separate those items that are programmed for all applications (System-Wide
Settings) from the features that may be customized for each application (Settings for:).  In the area to the right
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